
Using Crystal Reports with Lucity 

Intermediate – 1  

The third of a seven-part series, this workbook is designed for Crystal Reports® users with some 

experience. By now you have many of the skills needed to modify existing reports.  The main 

advantage to modifying existing reports is that the general format is already defined.  This format 

helps create a uniform look and feel for your reports.  It also helps save you the time it takes to set up 

the initial aspects of your reports.  These include items such as page numbers, date fields, title 

placement, logos, lines, size, spacing, and boldness, just to name a few.   

In this workbook, you’ll learn that creating new reports uses many of these same techniques, but starts 

with a blank page.  Through a series of step-by-step examples, we’ll show you how to create a Crystal 

Report from scratch. 
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Creating Reports 
Before creating a report it is a good idea to have a general idea of what you would like the report to 

look like.  You should know which tables, fields and calculations will be involved.  You should know 

which module the report will be run from. 

We would like a report to run from the Employees Setup module. 

It will show the Name, Job Title, Department, Supervisor and Active. 

It will group on Department. 

It will count the number of Employees for the Department. 

Report Wizard 
1. Open Work > Work Flow Setup > Employees. 

2. Ctrl right click all fields to be used in the report. 

o Table Name: WKUEMP 

o Fields:  Name: EM_EMPL_TY 

 Job Title: EM_TITLETY 

 Department: EM_DEPT_TY 

 Supervisor: EM_SUPR_TY 

 Active: EM_ACT_FLG 

3. Open Crystal Reports. 

4. Click on Standard Report Wizard. 

 

Bring in Tables 
5. Open Create New Connection >> ODBC (RDO) >> GBAWork001  >> Next >> Finish  >> Tables 

6. Move WKUEMP under Selected Tables (right-hand side).  

7. Click Next. 
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Bring in Fields 

8. Select the fields you would like to have in the report and move them to the right-hand box 

titled Fields to Display.   

 

9. Click Next. 

Field Grouping 

10. If you wish to group your data, select the grouping field and move it to the right side of the 

dialog under Group By.   

o Since we would like to group this report by Department, move the EM_DEPT_TY field 

to Group By. 

  

 

11. Click Next. 
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Summaries 

12. You may also choose fields to summarize.  

o For our example, we’d like to count the number of Employees (EM_EMPL_TY).   

o You’ll need to select the type of summary from the drop-down box at the bottom of 

the dialog.  For our example, we’ve chosen Count.   

 

13. Click Next. 

Group Sorting 
14. There is also a Group Sorting option.  There is only one group so this is already in the sort box.   

 

15. Click Next. 
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Chart Addition 

16. There is an additional option to add a chart.  For our example, we will not put a chart in at this 

time.   

 

17. Click Next 

Record Selection 
18. In the following dialog, you’ll see a Record Selection option.  We’ll use this option to view 

Active Employees only.   

o Move EM_ACT_FLG to the right side of the screen under Filter Fields.   

o Use the drop down box to choose the selection criteria.  For our example, we’ve 

selected is True.   

 

19. Click Next. 
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Template 

20. There are a number of Templates available to choose from.  Typically, you would choose No 

Template.   

 

 

 The other options are worth looking at and playing with.  It is easy to select one and 

preview the look. 

 

21. Select Finish when you are done. 
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The Report Wizard has created the following: 

 

 

Preview 

 

 

This report still needs modifications to make it presentable.   

22. Remove the Active field (EM_ACT_FLG) since the report is selecting on this field.  

23. Remove the EM_DEPT_TY field since it is the Group field. 

24. Add a text object in the Page Header for the Title (Employees By Department).   

o Resize and center the Title. 

25. Change the Column Headers (field headings) to match the fields. 

26. Modify the Summary Fields. 

a. Left align. 

b. Reduce widths. 

c. Remove the bottom borders. 

27. Change the Group Option to Keep Group Together. 
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28. Finally, save the report with an appropriate name under the Work family of reports 

(LC_EmpByDept.rpt). 

                                                                                                                              Example 15 
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Table Joins 
Usually in Crystal’s Database Expert the tables are linked with an outer join.  When there is information in 

the first table then it looks to the table it is joined to with the outer join.  This normally shows up with an 

arrow from the one to the other.  (Sometimes in older versions of Crystal the arrow point doesn’t show up, 

so the line looks like an inner join.  You have to click on it to figure out the kind of join that is being made.) 

Left Outer Join: 

 

There would need to be a work order before you would pull task information.  There would need to be a 

task before the resource information would show up. 

There are some cases within Lucity where an inner join is required.  One example is where both 

Subsegment and Road share the same table (STPVFLD) for storing Inspection data.  Chances are good 

that you would not use both Subsegment and Road so this shouldn’t be an issue but if you do, then an 

inner join would be the way to handle the information. 

Inner Join: 

 

 

Now in order to see records both tables would need to have data where FD_SB_ID is equal to SB_ID. 

 
A similar case is how the Traffic Volume table (STTVSEG) connects to Segment and Roads.  An inner 

join is again used. 
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Blank Report 
Reports can be made from a “blank slate”.  It will have the five sections open to add what you would 

like. 

We will create a Sewer Pipe report with Lamping data.  The Lamping data comes from a grid or child 

box. Usually there would be multiple lamping records to the one pipe, a one-to-many relationship.  If 

pipe and lamping fields were brought into the same Detail section of a report then the line would show 

for every Lamping record which would also duplicate the Pipe information.  This isn’t a good way to 

present the data. 

 

 

Typically there would be at least one group on a field from the parent table and then at least one 

group on a field from the second table. 

We would like a report to run from the Sewer Pipe Inventory module. 

It will show the Alt Pipe ID, US Structure, DS Structure, Size and Length. 

It will show Lamping Date Inspected (descending), Time (descending), US or DS, Cleaning and 

Deposition. 

It will group on Alt Pipe ID, Lamping Date and Time. 

It will show the most recent record (LP_LATEST) Lamping Date in red if it is not within the last year. 

1. Open Sewer > Inventory > Pipes 

2. Control right click all fields to be used in the report to find the field names. 

o Table Name for Pipe: SWNET 

 Fields:  Alt Pipe ID:    NT_NUMBER 

  US Structure: NT_USMAN 

  DS Structure: NT_DSMAN 

  Size:           NT_DIA 

  Length:          NT_LENGTH 

o Table name for Lamping: SWLAMP  

 Fields:  Date Inspected: LP_DT_INSP 

  Time Inspected: LP_TM_INSP 

   US or DS:           LP_INMH_TY 

  Cleaning:           LP_CLN_TY 

  Deposition:        LP_DPO_TY 
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3. Open Crystal Reports and click Blank Report. 

 

Bring in Tables 
4. Next, open Create New Connection >> ODBC (RDO) >> GBASewer001 >> Finish. 

5. Move the SWNET and SWLAMP tables to the Selected Tables section. 

6. Click OK. 

 

Link Tables 
7. This should bring you to the Links section where the two tables will be connected.   

a. Sometimes the link has already been added – this is Crystal’s best guess and is usually 

incorrect, so delete it.  Click and select Clear Links. 

b. Find the common linking field.  Typically this would be an ID field with a common part.  

If this isn’t obvious, check the Detail report that is provided with the module and see 

how the tables are connected. 

 NT_ID links to LP_NETID 

c. Typically it is good practice to have the main table (parent table, the table of the 

module you are running the report in) in the top left corner.  Then additional tables 

are linked from there.  The tables can be moved by clicking on the top bar of a table 

and dragging it to a new location. 

o Click on the Main ID of the parent table (NT_ID), hold and drag to the 

connecting field of the other table (LP_NETID), release.   

 A line has been created. 

o Right click on the line and select Link Options… 
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d. The Join Type by default is Inner Join (both table values are equal to see a record).  

The majority of the time this join should be Left Outer Join (It will show all records in 

the Parent table whether there are records in the linked table).  

o Change to Left Outer Join. 

 

 

o OK 

e. When you click off the line, the line now has an arrow pointing from the parent table 

to the linked table. 

 

8. Click OK. 
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You now have a blank page to create a report. 

 

 

9. Give the report a name.  File >> Save As. 

a. Make sure you save the report in the proper report file.  For our example, select the 

Sewer file. 

b. The name for this report will be LC_SWPipeLamping.rpt. 

The report can be created using any of the previously discussed techniques.   

10. Insert a logo in the Report Header. 
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Special Fields 

11. In Field Explorer, open Special Fields.  There are a number of preset fields which aid in the 

report design. 

o Drag in the Page Number, Print Date, and Print Time preset fields. (For a long report 

avoid the “Page N of M” option, it slows down the report run) 

 

12. Create a report title in the Page Header section.  

a. Bring in a text object; we’ve titled this one, Sewer Pipe Lamping Summary Report.  

b.  Increase the field size and format to font 16, Italic. 

13. Enter Column Titles with the Insert Text Object function.  

a. Right align Size and Length. 

b. Add guide marks.  

c. Align tops of Column Titles. 

d. Add a line to the bottom of the Page Header section. 
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14. Insert Group (NT_NUMBER).   

15. Drag the appropriate fields into the Group Header 1 section.   

o Align top of fields. 

16. Suppress the Group Footer 1 section.   

o Right click in left margin next to GF1, select Suppress. 

17. Add an additional section to Group Header 1. 

o Right click in the left margin of GH1, select Insert Section Below. 

18. Place Lamping Title and Column Titles in the Group Header 1b section. 

a. Format Not Bold, Italic and Column Titles underlined. 

b. Align Column Titles. 

  

19. Insert Group on Pipe Lamping Inspected Date (LP_DT_INSP).  GH2 

a. Select from drop box In descending order. 

b. Click OK. 

c. Suppress the Group Header 2 and Group Footer 2 sections.  

20. Insert Group on Pipe Lamping Inspected Time (LP_TM_INSP).  GH3 

a. Set up like the Date group - In descending order. 

b. Suppress the Group Header 3 and Group Footer 3 sections. 

21. Create formulas for the Lamping Date and Time fields. 

o Date({SWLAMP.LP_DT_INSP}) 

o Time({SWLAMP.LP_TM_INSP}) 

22. Bring into the Detail section the newly created Date and Time formulas. Bring in the other 

desired Lamping fields. 

o Align 
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Conditional Formatting 
23. Conditionally format the @LampDate field to show red if the latest date is over a year old. 

a. Right click @LampDate, select Format Field… 

b. Font Tab, click the formula box next to Color:. 

c. Enter the following formula: 

d. if ({SWLAMP.LP_LATEST} and {@LampDate} < printdate - 365) then crRed else crBlack 

e. Save and close 

f. OK 

 

 

Blank Lines 
In the previous example, Pipe 1003 shows the Detail section as empty space when there are no 

Lamping records. It also shows the Lamping Header Titles in GH1b. 

These issues can be addressed in two ways. 

 You could remove pipes that do not have Lamping records by changing the Table linking to  Inner 

Join. 
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      OR 

 If you want to keep the pipes and will use the report to find pipes that have no lamping records 

then suppress the GH1b and Detail sections when there are no records. 

a. Click on Section Expert . 

b. Click on Group Header #1b to highlight. 

c. Click on the formula box next to Suppress. 

d. Enter the following formula: 

e. isnull({SWLAMP.LP_NETID}) 

f. Save and close (formula box is now red) 

g. Click on Details to highlight. 

h. In the right box click to check the box next to Suppress Blank Section. 

i. OK 

   

 

                                                                                                                                          Example 16 

Mailing Labels 
Another report option in Crystal Reports is a way to create a report for mailing labels.  For our 
example, we will create a report for Work Order Billing labels.   

1. Open Crystal Reports and click Mailing Label Report Wizard 

2. Open Create New Connection. 

3. Open ODBC(RDO). 

4. Select the required table(s). (WKORDER) 

(If you are going to filter or select on any fields that are not in WKORDER, even if they are not 
used in the body of the report, then you will need to select these other tables and link them as 
previously discussed.) 

5. Select the fields to be displayed. 
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6. Select the mailing label type from the drop down box. 

 

 

 There are other options on this page to choose from.   
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7. Select Next.  The next page allows you to select a filter field.  After that step, the report will 

appear: 

 

 

 The second column in gray is automatically created. 

 

Preview 

 

 The fields were each placed in their own Detail section, thus stacking the information.  

You could move the fields around placing the Last name after the First and the State after 

the City; however, this frequently creates awkward spaces. 

8. You would probably want to concatenate some fields by creating formulas to combine the two 

name fields and the City and State fields. 

 

Name Formula: 

 
(If IsNull({WKORDER.WO_BFIRST}) Then " " Else {WKORDER.WO_BFIRST})&" "& 

(If IsNull({WKORDER.WO_BLAST}) Then " " Else {WKORDER.WO_BLAST}) 

 
City/State Formula: 
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(If IsNull({WKORDER.WO_BCITY}) Then " " Else {WKORDER.WO_BCITY})&", "& 

(If IsNull({WKORDER.WO_BSTATE}) Then " " Else {WKORDER.WO_BSTATE}) 

 

 

 

 

Notes:__________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________ 

Preview 

 

9. If any changes need to be made to the layout of the report, click on the Section Expert. 

10. Click Details and a Layout tab will appear.  

11. Click on the Layout tab and make the necessary changes. 
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Notes:__________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________ 

_______________________________________________________________________________ 
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Intermediate – 2 

The fourth of a seven-part series, this workbook is designed for Crystal Reports® users with some 
experience.  Here, you’ll learn how to add subreports.  Specifically, we’ll look at the Work Order 
Locations subreport and the module’s Comment section.  Both the general Comment sections and the 
Work Order/Request Comment sections will be addressed. 
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Subreports 
Subreports are simply reports within other reports.  They can stand alone or be linked.  Lucity typically 

uses subreports to display information stored in the child records (shown in grids or dialogs), 

information from other related modules, and the Comments sections.  Subreports can vary in size and 

can be placed wherever you wish.  Typically, subreports are inserted into their own Detail section.   

One issue with subreports is the data in a subreport does not receive the filter out in Lucity.  If this is 

required, then try to use grouping as previously discussed. 

A second issue with using subreports is that it is not possible to place a subreport within another 

subreport.  Thus, it can be challenging to show the child of a child relationship.  Usually this is handled 

with grouping in a subreport. 

A third issue is that each subreport is seen as a separate report when the report is run. If there are 

many Web users running reports at the same time then the system can slow down.  

Accessing Subreports 
A few Detail reports have subreports that may be minimized to a point where you cannot read the 

titles.   

1. In the Reports Work file open the CatRes.rpt report. 

2. The minimized sections below the Detail section contain subreports. 

 

3. To view the subreport title, place the cursor over a subreport and the name will appear briefly 

(if the Tooltips are turned on).  To open the subreport, simply double click on it.   

4. It is also possible to navigate to a subreport using the Report Explorer .  Make sure the 

Show/Hide Grids and Subreports is turned on .  Then click on Expand .  Subreports can 

be opened from this section or from the subreport itself by right clicking on the subreport 

name and selecting Edit Subreport.   

Inserting a Work Order Locations Subreport  
The data in many of the grids in the Lucity modules can be connected to the parent report.  In the 

following example, we’ll demonstrate the use of a subreport to bring in the information from the Work 

Order Location grid in the Work Orders module to the Aging Work Order Report.   

Finding Tables and Fields 

1. In the Work Order module open a record in the Work Order Location grid to find field 

definitions. 
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a. Open the Work>>Work Orders>>Standard module and click on the Location tab. 

b. Open an existing record in the Work Order Location grid (right click – View Record) or 

right click in the grid and select Add Record. 

c. Find the field definition of the General Location field by pressing Ctrl and right clicking 

on the field and selecting Field Definition or Field Properties.  There, you’ll see the 

following: 

 The table name is WKORDERLOC. 

 The field name is WL_GENLOC.  

d. If you do the same thing to the second field of the Address, the field name will show up 

as WL_ADR_DIR. This is not the correct field name for the information in the box. It is 

only one of the fields that are joined to create the address in this box. Thus, a formula 

is needed to address all the fields in a concatenated formula. Not all of the modules 

use this special address that pulls from the General Address module, some allow you to 

manually type in the address and store it in a single field. 

 

 

 

2. We will modify the Aging Work Order Report (WOsAging.rpt) from the Work module. In the 

Work report folder open LC_WOsAgingLoc.rpt. 

3. Open the new report and delete the WO_CAT_TY field. 

4. Delete the WO_PROB_TY field. 

5. Change the Category column header to Address. 

6. Change the Problem column header to General Location. 

7. Click the Database Expert button .  
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8. Open the Links tab and note where the “tree” of tables begins; most often it is the top table 

on the far left side (frequently, this is the table the subreport will link to).   

 For example, this tree starts with the WKORDER table.  

 

9. Close the Database Expert. 

Inserting the Subreport 

1. Click Insert Subreport .   

a. You’ll need to type in the New report name.  For example, we’ve called this subreport, 

Location.   

 

b. Then, select the Report Wizard.   
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2. Open Create New Connection > ODBC (RDO) > GBAWork001 (Finish key) > Tables.   

a. Select the WKORDERLOC table and move it to the Selected Tables box on the right-

hand side of the screen. 

 

 

b. Click Finish. 

c. Click OK. 

3. Place the subreport “box” in the Detail section with the left edge aligned with the left edge of 

the Address column header. 

4. Resize the box to fit under the Address and General Location area. 
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Formatting the Subreport 

Right click in the Location subreport box and click Format Subreport.  Choose the formatting options 

that you prefer. 

o For example, in the Format Editor dialog below, we’ve selected to center the report 

title.  You can see a sample of your formatting selections at the bottom of the Format 

Editor dialog. 

o The Keep Object Together option can cause issues with large blank spaces. 
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o  Additionally, we’ve chosen to not use a predefined border. 

 

o For the subreport title we’ve chosen 10 point Arial for our font, and made the text red. 

 

o Finally, we’ve chosen to Suppress Blank Subreports.              
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o Once you’ve finished selecting your formatting options, select OK. 

 

Note: Some of the formatting options are strictly for the creator of the report like having 

the title centered and red.  When working on a report this is a quick visual as to which parts 

of the report are subreports.  Some of the formatting will affect the user end of the report 

like the border lines, empty space or whether the subreport Can Grow. 

 

Subreport Links  

Subreports can stand alone; however, typically they are linked to the main report. You’ll need to find 

the correct table and field to link your subreport to.  This will allow the main report and subreport to 

communicate effectively. 

1. Right click in the Location subreport box and select Change Subreport Links. 

 The linked tables usually have an ID field with a common part; in this case it is WO. 

2. Open the WKORDER table and move the WO_ID field over to the Field(s) to link to box on the 

right-hand side of the screen.  

3. Click the arrow beside the field at the bottom-right of the screen and select the WL_WO_ID 

field.   

4. Click OK. 

 

 

The linking creates a formula in the Subreport in the Select Expert. 

{WKORDERLOC.WL_WO_ID} = {?Pm-WKORDER.WO_ID} 
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Note: The Web reports require any linking formula to have the “?Pm-XXXX”  type formatting.   

This is automatically created through Crystal when using the Subreport Links dialog box.  

Remember to use this format if creating manually. 

Adding Fields to the Subreport 

The subreport is basically a report and so it has the various options of a report such as Select Expert, 
Section Expert, Grouping and Sorting. 

1. Open the Location subreport by double clicking  

 OR right click and selecting Edit Subreport…. 

2. There will always be at least three sections; the Report Header, Detail and Report Footer.  

Suppress all sections other than the Detail section. 

3. As mentioned earlier the address is a concatenated field.  This formula will be borrowed from a 

standard report. 

a. Open the Work Order Detail report (WODetail.rpt). 

b. Locate the Locations.rpt subreport and double click on it. 

c. Find the address formula within the report (@Addy).  Right click on it and click Copy. 

d. Close WODetail.rpt. 

4. Go back to the LC_WOsAgingLoc.rpt report. 

5. Make sure you are in the Location subreport.  Paste the address formula into the Detail 

section. Resize. 

 The address formula is shown below: 

 

6. Open Field Explorer > Database Fields > WKORDERLOC. 

7. Drag the WL_GENLOC field into the Detail section. 
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Preview 

 

8. Save and close the report. 

                                                                                                                             Example 17 

Copying a Subreport 
You can use an existing subreport or report in the same family (i.e. Work, Sewer, Storm, etc.) as long 

as you are careful with the linking.  In our example below, we’ll show you how to copy the more 

detailed Location subreport from the Work Order Detail Report and place it in the Summary Report. 

1. Open WODetail.rpt. 

2. Right click on the Location subreport and select Save Subreport As. 

a. Make sure you are in the correct report file (Work). 

b. Enter a File Name (LocationsSub.rpt).   

c. Save the subreport and close the Detail report. 

3. We will modify the Work Order Summary Report (WOSum.rpt) from the Work Order module.  

From the Work report folder open LC_WOSumDetLoc.rpt. 

4. Delete the Address column title. 

5. Delete the Locations subreport. 

6. Add a new section under Group Footer 1a and increase the size slightly to accommodate the 

new subreport. 

7. Select Insert Subreport. 

a. Click Choose an existing report. 

b. Click Browse. 

c. Locate the Reports\Work folder and double click on LocationsSub.rpt.  You’ll see the 

Insert Subreport dialog box. 

d. Click OK. 
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8. Place the subreport “box” in the newly created Group Footer 1b section. 

9. Choose the desired subreport formatting options discussed earlier.   

10. Resize to fit the report. 

11. Right click on the subreport and choose Change Subreport Links.  

 {WKORDERLOC.WL_WO_ID} = {?Pm-WKORDER.WO_ID} 

12. Open the subreport and delete any empty sections. 

13. Open the Select Expert and delete one of the parameter formulas.  Even though the correct 

formula existed in the subreport’s Select Expert, the main report doesn’t recognize it, so it 

needed to be linked correctly again. 

 {WKORDERLOC.WL_WO_ID} = {?Pm-WKORDER.WO_ID} and 

{WKORDERLOC.WL_WO_ID} = {?Pm-WKORDER.WO_ID}   

 You’ll see a duplicate formula because the subreport was taken from a report with the 

same parent table.  Delete one of the duplicate formulas or if they differ then keep the 

formula that reflects the correct linking, deleting the other.  

14. Select Save and Close. 

15. OK 

  

Note:  Do not use a subreport from one family of reports in another family, such as a Work 

subreport in a Sewer report.  

                                                                                                                                  Example 18 
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Grid Data with Associated Data 

There are several cases throughout the Lucity modules where you click on data in one grid and 

information associated to that record shows up in the lower grid. A good example of this is in the Work 

Order module where the Resources are listed for each Work Task. 

 

 

 

The TaskRes.rpt subreport in the Work Order Detail report (WODetail.rpt) shows this relationship. 

 

 

 

The first group (GH1) is the Work Task and the second group (GH2) is the listing of the Resources 

associated with each Task. 
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Another example is in the Fleet module where the Sub-Components are associated with each 

Component. 

 

 

In the Fleet Detail report (FLDet.rpt) a subreport (Items-Components) groups on the Components (GH1) 

and shows the subcomponents in the Detail section. 
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There is an additional type of grid association. Within the Work Order module, Links tab, you’ll see a Daily 

Inspections grid. Within each Daily Inspection record there are several grids containing information. 

 

  

 

  

 

Notes:______________________________________________________________________________ 

____________________________________________________________________________________ 

____________________________________________________________________________________  

____________________________________________________________________________________ 

____________________________________________________________________________________ 

____________________________________________________________________________________  
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At first glance, it would appear the only way to show this data would be a subreport within a subreport; 

however, this is not possible at this time. Sometimes it is possible to link the grid table and group. The 

following Inspection subreport shows the Equipment associated with each Inspection date. 

 

 

 

The report groups on the Inspection Date (GH1) and then lists the Equipment for that Inspection record in 

the Detail section. 
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Date Parameters to a Subreport 
Frequently subreport records need to be selected for a date range.  If the main report and subreports 

are using the same date range then the date parameter should be created in the main body of the 

report and linked to the subreport(s).  If only the subreport requires the date selection then the 

parameters can be created within the subreport. 

The Fleet Cost Report (FleetCost.rpt) passes the parameters from the main body to both the fuel 

subreport and the Work Order subreport.  

First the date parameters were created in the main body of the report. 
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Within the Fuel subreport the date formula that will be used with the parameter dates was placed in 

the body of the report.  

  

 

The parameter fields were brought to the subreport in the subreport linking. 
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The linking process set the fields up in an “=” formula.  This was changed in the Select Expert in the 

subreport. 

 Formula Crystal created: 

{@date} = {?Pm-?Start} and 

{@date} = {?Pm-?End} 

 

 Changed to: 

         {@date} in [{?Pm-?Start} to {?Pm-?End}]  

The date parameters were brought to the Work Order subreport in a similar manner. 

It is a good practice to make sure formulas and parameters have unique names within the report.  

There should not be duplication of names from the main report to the subreports.  The web reports will 

not support duplicate parameter names. 

Our Web code looks for parameters that start with “Pm-“, it assumes these are subreport linking 

parameters and does not ask the user to provide this data.  If you do not follow this convention our 

software will prompt you for the parameter values instead of letting Crystal automatically set those 

values.                                                                                                                             Example 19 

Adding a General Comments Section  
(Not Valid for Dated General Comments in Work Orders or Requests) 

The system handles Comment grids differently than other types of grids in Lucity.  For these grids, the 

information is stored in a MEMO table.  The parent table communicates with this MEMO table to 

retrieve the Comment information.  Typically in the Field Definition for the Comment section the field 

name will be MEMO1 or MEMO2 and the table shows as the parent table of the module you are currently 

in. This is misleading because the field is not in this table.  

In the example below, we’ll show how to add the Comment field for the Storm Conduit Inventory 

module to the Conduit Physical Data Check Report (SMcnphck.rpt).  These same steps are used to 

add Comment sections to all modules other than the Work Orders and Requests comment section.  It 

will work for the Memo type fields in Work Order like Comment From Request or in Request like the 

Information for Work Order memo fields. 

Option 1 – Creating a Subreport from Scratch 

1. First we’ll locate the field definition information for the Comment section.  

a. From Storm open the Conduit Inventory module and click on the Comment tab.   

b. Use the Ctrl + right click function to view the field definition.  Make a note of the table 

name (SMVCONDT) and field name (CN_MEMO1).  The SMVCONDT table is NOT where 

the data is stored.  The data is in the SMMEMO table.  All Storm comments are stored 

in this table. 

2. We will modify the Conduit Physical Data report (SMcnphck.rpt) from the Storm Conduit 

Inventory module. From the Storm reports folder open LC_SMConChkCom.rpt. 

3. Right click in the margin to the left of the Details section and select Insert Section Below. 
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4. Increase the size of the new section slightly to accommodate the new Comment subreport. 

5. Click Insert Subreport .   

a. Type in the New report name (Comment). 

b. Select Report Wizard.   

6. Open Create New Connection > ODBC (RDO)  > GBAStorm001 (Finish key) > Tables.   

a. Select SMMEMO and move it to the right-hand box, Selected Tables. 

b. Click Finish. 

c. Click OK. 

7. Place the “box” in the Details b section. 

8. Right click in the Comment subreport box and click Format Subreport.  Choose the formatting 

options that you prefer. 

9. Select OK. 

10. Resize the subreport box. 

11. Right click in the Comment box and select Change Subreport Links.  The Field to link to will be 

the ID field for the table referenced when checking for the field name in step 1, SMVCONDT. 

a. Open SMVCONDT and move the CN_ID field over to the Field(s) to link to box on the 

right-hand side of the screen.   

b. Click on the arrow beside the box at the bottom-right of the dialog and select the 

CO_REC_ID field.   

c. Click OK. 
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12. Double click on the Comment subreport box.  You are now within the subreport.   

13. Click on the Select Expert .   

a. Click on the New tab. 

b. Click on the CO_FIELD and then OK. 

c. Click on the down arrow within Select Expert and select “is equal to”. 

d. Click on the down arrow for the right hand drop down box.  Select “CN_MEMO1”.  (The 

comment field name, CN_MEMO1, was previously found using the Field Definition.) The 

field is only available in the drop down box if there is a record that has the Comment 

field populated with data. Otherwise, type in the field name. 

 

 

e. Click OK. 

f. To view the formulas created within the Select Expert, click on Select Expert and then 

Show Formula>>>. 

  {SMMEMO.CO_REC_ID} = {?Pm-SMVCONDT.CN_ID} and 

  {SMMEMO.CO_FIELD} = "CN_MEMO1" 

 

Note:  The CO_REC_ID and CO_FIELD are the same for all general Comment subreports; 

however, the linking table and the field name in quotations changes for each module.  The 

XXMEMO table name also changes depending on which suite of modules you are working in.  

For example, Street is STMEMO, Water is WTMEMO etc. 

 

14. Suppress Report Header a and b and Report Footer a and b.   

15. Create a “Comments” text object field in the Detail section.   

16. Drag in the CO_TEXT field from Field Explorer and resize the field.   

o It is important that the CO_TEXT field be able to grow, so remember to check the Can 

Grow option within Format Field.  Right click on the field and select Format 

Field>>Common (tab)>>Can Grow (checked)>>OK. 
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17. Click on the Design tab and then the Print Preview button . 

 

 

 

Preview  

  

 

18. If you had tried to Preview the report while still in the subreport, something similar to the 

following would appear: 

 

 

19. Press Cancel and then go to the report Design tab to run the report. 
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20. After reviewing the report, further modifications may seem necessary to make it easier to 

read.   

o In our example, a line should be added below the Comments line. 

21. Add a Detail section below Detail b.   

22. Add a line to Detail c.  

23. Format the line to silver. 

24. Even when a record has no comments, the space for the Comments subreport will still appear.  

This space can be removed as follows: 

a. Click Section Expert .   

b. Click Detail b and select the Suppress Blank Section option.   

c. OK. 

 

Preview 

 

 

Option 2 – Creating a Subreport with the Report Wizard 

 

1. We will modify the Conduit Physical Data report (SMcnphck.rpt) from the Storm Conduit 

Inventory module. From the Storm reports folder open LC_SMConChkCom2.rpt. 

2. Add a Detail section. 

3. Click Insert Subreport. 

o Name it Comment, and click Report Wizard. 

4. Open Create New Connection > ODBC > GBAStorm001 > Next > Finish > Tables. 

5. Move SMMEMO to Selected Tables.  Then click Next. 

6. Move CO_TEXT to Fields to Display.  Then click Next. 

7. There will be no grouping, so select Next in the Grouping dialog box. 
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8. In Record Selection, move the CO_FIELD to the Filter Fields.   

o Using the drop down box, select is equal to. 

o Using the next drop down box, select CN_MEMO1.  Then, click Next. 

9. Select No Template and Finish. 

10. Select the Link tab. 

o Set this up as described in Option 1. 

11. Select OK and drop the new subreport box in the new Detail section. 

12. Set up and format the subreport as described in Option 1. 

                                                                                                                        Example 20 

Adding a Comments Section to Work Orders and 

Requests and Dated Comments for Inventory Modules 
The Comment tab within Work Orders and Requests is formatted differently than the Comment 

sections in other modules.  For this example, we’ll add a Comment subreport to the Work Order 

Summary Report. 

1. First, we’ll find the field definition for the Work Order Comment section. 

a. Open the Work Orders Standard module.  Click on the Comments 

tab.

 

b. Right click in the grid.   

c. Select Add Comment or View Details for an existing comment.   

d. Ctrl + right click in the large comments box to view the field definition.  Note that the 

table name is WKGDMEMO and the field name is GM_MEMO.   

e. Close the comment dialog. 

Note: This Comment section does not hit the WKMEMO table.  Instead, it uses the 

WKGDMEMO table. 

 

2. We will modify the Work Order Summary Report (WOSum.rpt) from the Work Order module.  

From the Work report folder open LC_WOSumComment.rpt.   

3. Right click in the left margin of the Group Footer 1a section and select Insert Section Below. 

4. Click Insert Subreport .  

a. Type a name for the subreport (Comment) in the New report name section.   

b. Click Report Wizard.   
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5. Open Create New Connection > ODBC > GBAWork001 (Finish) > Tables.   

a. Move the WKGDMEMO table to Selected Tables.   

b. Click Finish. 

c. Click OK.   

6. Insert the Comment “box” into the Group Footer 1b section. 

7. Choose subreport formatting options and resize the box. 

 

 

 

8. Next, right click within the Comment box and select Change Subreport Links. 

a. Select fields so it looks like the following:  

 

 

b. Click OK. 

 

9. Double click on the Comment box. You are now in the Comment subreport.  

a. Click Select Expert and click the New tab. 

b. Click and highlight GM_PARENT. 

c. Click OK. 

d. With the drop down arrow select is equal to. 
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e. With the right drop down box select WKORDER.  (This will only show as a choice if 

there is at least one record with a comment.  Otherwise type WKORDER.) 

f. Click OK. 

 {WKGDMEMO.GM_PAR_ID} = {?Pm-WKORDER.WO_ID} and 

 {WKGDMEMO.GM_PARENT} = "WKORDER" 

Note:  The formula in Requests would look like this: 

                   {WKGDMEMO.GM_PAR_ID} = {?Pm-WKREQ.RQ_ID} and 

          {WKGDMEMO.GM_PARENT} = "WKREQ" 

 

10. Add column titles.  You’ll want to make the titles bold and underlined in order to make them 

distinct. 

11. Drag in the appropriate fields.  

 You’ll need to create formulas before you can add the Date and Time fields. 

12. Increase the size of the GM_MEMO field and format it so it Can Grow. 

13. Place a box around the Comment subreport to separate it from the rest of the data.  Make sure 

the bottom of the box is in the Report Footer section so the box will grow to accommodate the 

Memo field if necessary.  

a. Add a title for the box (Comments).  

b. Format the Comments text box with a white background (Format Editor > Border tab > 

Color: Background checked with White). 

 

 

 

14. Click the Design tab.   

15. Click the Section Expert button.   

a. Select Group Footer1b and the Suppress Blank Section option.   

b. Select Group Footer 1 and the Keep Together option.   

c. OK 
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Preview 

  
 

The Inventory modules have a second grid in the Comment tab with Dated Comments.  The table will 

be obvious from the field definition and should reflect the suite of modules.  For Storm - SMGDMEMO, 

for Sewer – SWGDMEMO etc.  The setup would be similar to the Work/Request comment setup. 

                                                                                                                                          Example 21 

 

 

 

 

 

 

 

 

 

Notes:______________________________________________________________________________ 

____________________________________________________________________________________ 

____________________________________________________________________________________  

____________________________________________________________________________________ 

____________________________________________________________________________________ 

____________________________________________________________________________________  

____________________________________________________________________________________ 
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Unlinked Subreports 
 

There are times when the subreports do not need to be linked.   

 This can be used when running individual reports as subreports in one document.  This can be 

useful in a Year End Report.  

 In Lucity Detail reports the Custom User field captions are brought in by setting up variables in 

an unlinked subreport and passing these values into the main report.  (More on variables in the 

Advanced 2 section) 

In Lucity software the button captions may be altered to suit individual needs. These field captions 

may be reflected in the report by one of the following methods:   

 Add or Edit the appropriate text object in the report as discussed in the related Beginning 

Crystal workbooks. 

 Pull the value that is stored in the database and display it on the report using an unlinked 

subreport with variables. 

 

Lucity uses this type of unlinked subreport in many of the Detail reports.  It is hidden in a Report 

Header subreport.  It contains a formula declaring variables that are associated with the User button 

captions in the Custom tab. 

 

 

 

The @StoreUserBtns formula appears on the following page.  Note that this is only part of the formula.  

We’ve included this to make you aware of what happens behind the scenes.   

 

Any line starting with // is just a comment; it is not part of the formula.   

 

The formula for each User button caption looks something like this: 
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